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Introduction
iMovie is an Apple application for creating digital video and slideshow projects. The program is 
specifically designed to work with Apple’s FireWire hardware, and is not compatible with PCs. 
iMovie can help you create videos to burn on DVD, show on your computer, or upload to sites 
such as YouTube.

In order to work with iMovie, you will need to have a playback device (such as a VCR or a cam-
corder) and a firewire cable to connect the playback device to your computer. If your playback 
device does not have a firewire output, you will need to use a converter. If you are working in the 
DC Training Lab, DVD players, VCRs, miniDV playback machines, converter boxes and firewire 
cables are provided.

Open iMovie-HD and Create a Project
1. Make sure your playback device is properly connected to your computer. In the lab, make sure 
the playback device is connected to the converter box with RCA cables, and the converter box is 
connected to the computer with a Firewire cable.

2. Using a finder window, create a folder for your iMovie 
project within the Patron Storage folder on the Data 
Drive.

3. In the same finder window, go to Applications and 
find iMovie HD under iMovie (previous version). Double 
click on iMovie HD to open.

4. Click “Create a New Project”.
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5. Name your project. Set the file path to the folder you created in Step 2. Click “Save”.

6. iMovie will open your project in a window with a display containing: a viewing screen, a shelf 
for clips, a timeline, a toolbar. It should look like this:

Capture Video
Capturing video is a real time process in which your video footage is converted to a DV file for 
use in iMovie. Because video capture happens in real time, you can watch it as it is captured. If 
you already have a DV file (or another digital file type), you may not need to capture your video.
Instead, you can go to File         Import and open your video file directly in iMovie for editing.

Video can be captured from one of three main sources: a VCR; a DVD player; or a camcorder 
in playback mode. The following instructions for video capture apply to these three types of 
devices.

There are also two main methods of capturing video: capture everything from a source tape/ 
disc at once, and break it up into separate clips while editing OR capture each clip separately, 
simply repeat the steps outlines below for each clip you capture.

To Capture Video:

1. Connect your playback device to your computer using a FireWire cable. If you are using a 
DVD player or VCR, you will need a converter to run from RCA to FireWire (these are provided 
at the two video DC Training Lab stations). Again, if you are using a camcorder, make sure it is 
set to playback mode rather than record mode.

2. Make sure you are in “Capture Mode” and not “Edit Mode” in iMovie. Your mode options are 
located just below your viewing screen and look like this:
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3. Cue your tape or disc to 10 seconds before you would like to begin your capture and pause it. 
You will need to control your playback device by using its play, rewind, fast forward and pause 
buttons.

4. Click the “Import” button in iMovie and then immediately hit play on your playback device. 
iMovie’s “Import” button is located towards the bottom and center of the viewing screen and 
looks like this:

As your footage is imported, you can view it in the viewing area. A small thumbnail should also 
appear on your clip shelf. The running count on this thumbnail is the length of time currently 
captured in the clip.

5. When you are ready to stop the capture for the current clip, hit “Import” again. Your clip on 
the Clip Shelf will become fixed and will stop increasing in length.

6. If you wish to capture additional clips from your original footage, repeat the steps outlined 
above.

7. If you are finished capturing footage, switch to “Edit mode” (see step 2). Go to the File menu 
and save your project.

Proceed to the Edit Video section (page 4) for instructions on editing video.

Import Files
If you already have a DV file (.dv or .mov), you do not need to go through the real time capture 
process. Instead, you can import the file itself into your iMovie project. You can also use the im-
port function to add audio files and still images to your project.

If you have a video file in a format other than DV, you may be able to convert it to DV using Epi-
sode Pro. Please ask a staff member for assistance if you would like to do this.

To import a DV file:

1. First, make sure you are in “Edit Mode” and not “Capture Mode”.
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2. Go to File         Import in the iMovie menu bar.

3. In the dialog box, navigate to the file you wish to 
import and select it.

4. iMovie will now import your file and create a thumb-
nail for it on your Clip Shelf. This process may take a 
few minutes (duration of process is dependent upon 
the size of the file being imported).

5. Repeat this process for each file you wish to import.

You can use this process for importing audio files and still images from .jpgs as well.

Edit Video
Editing is the process of taking your clips and creating a continuous video out of them. This 
includes trimming extra footage off of the beginning and end of a clip, pulling a desired scene 
from a larger clip, and arranging the clips in the order you want them to appear in the finished 
project.

To edit video in iMovie, you will use your Clip Shelf, the viewing screen, and the Timeline. You 
will also need to use the “Edit” menu (or keyboard shortcuts) for “cutting” your clips.

You can edit in either clip View (which represents each clip with the same thumbnail image dis-
played in the Clip Shelf) or Timeline View (which represents each clip with a bar corresponding 
to length of the clip itself). 

It is generally easier to edit in Clip View, but this view does not allow for watching successive 
clips. Therefore, it is recommended that you edit in Clip View, but switch to Timeline View to 
watch transitions from on clip to another or to check for the flow of the overall project.

Here are the basic steps to editing video in iMovie:

1. Select a clip. You can choose to view and 
trim your clips in the order you captured 
them, or in the order you want to place them 
in your final project. Based on your preferred 
method, select a clip.

2. In your Clip Shelf, single-click on the clip 
you wish to edit to view it in the viewing 
screen.
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3. Click the Play button to play the clip. Watch the clip and determine whether you want to use 
the whole thing, or just a portion of it.

4. If you want to use a portion of the clip, pause the clip at the point at which you want to cut it 
(the “splicing point”). This will place the playhead at the splicing point. If you want  to use the 
entirety of the clip, proceed to step 7.

5. Go to the Edit menu and select “Split 
video clip at playhead”. This will create 
two clips from what was once a single 
clip: one clip composed of everything 
coming before the playhead point; one 
clip composed of everything coming after 
the playhead point. One of these clips 
will be “the leftovers”, and the other will 
be what you plan to use in your project.

6. If the clip you plan to use in your 
project still has extra footage at the 
beginning or end (i.e. the side opposite 
the one you just edited), repeat the steps 
outlined above on it.

7. Your clip is now ready to be inserted into your project. Click on the clip and drag it into the 
Timeline.

8. Once clips are in the Timeline, you can click and drag them to change their order in your proj-
ect.

9. Repeat the steps above for each clip you wish to include in your project.

10. To review your project, or transitions between clips, switch from Clip View to Timeline View 
in the Timeline. Hit the “Play” button.

Add Transitions
You can add transitions (such as fades and dissolves) quickly and easily using iMovie. To do so, 
you will need to use the Timeline as well as the Transition Tool. 

The Transition Tool is located in the Tools bar, which is located just below the Clip Shelf. First go 
to “Editing” in this Tool bar, then select “Transitions” at the top of the editing window. 

To Add a Transition:

1. Select the clip you wish to add a transition to by clicking on it once. This will highlight it in 
blue.

2. Click on the “Editing” button in the Tools bar.
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Your clip shelf will be replaced
with the Editing Pane, which has 
tabs for Titles, Transitions, Video 
FX and Audio FX. Select the Transi
tions tab.

3. Select a transition by clicking 
on it once. You can preview them 
in the viewing screen before ap-
plying them to your project.

4. If you want to change the length 
of the transition, you can do so 
by moving the Speed Slider.

5. Once you have the transition 
as you would like it to appear in
your project, click on it and drag it 
to your Timeline. Attach it to the 
clip you want to connect it to and 
release the mouse.

6. Preview the transition in your timeline. Make sure you are watching it in Timeline View rather 
than Clip View.

7. Repeat the steps above for additional transitions.

8. To edit a transition, you will need to delete the transition and start over.

Add Titles
Titles include all text that is not 
contained within one of your cap-
tured video clips. This text can  
include the title of your film, sub-
titles, intertitles and credits. Titles 
can be displayed over a black 
screen or layered over one of your 
video clips.

To add titles to your project:

1. First click “Editing” in the Tools 
bar, then select “Titles”. The Titles 
pane will open.

2. Click on a Title in the dropdown 
window to preview it. Click on the 
arrows at the left to expand the 
menu and view all titles.

3. Choose a Title to use, and 
single-click on it to select it.

4. Change the font size, type or color using  the font options available below the Titles dropdown 
menu. 
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5. Select “Over black” if you want your text to display over a black screen. Deselect this option if 
you want the text to display over one of your video clips.

6. Type the text you wish to include in your titles in the text box at the bottom of the Titles pane.

7. Adjust the duration of your title (and its effects) by using the Speed Slider.

8. Adjust the amout of time your title will continue to display after effects have finished by using 
the Pause Slider.

9. When your Title options have all been set, select the clip before which you would like the title 
to appear. Then click on “Add”. 

10. Your title will appear as a clip in your timeline. You can now edit it as you would any other 
clip.

Add Chapters
Chapters act as markers for your DVD playback device, allowing it to know where to jump if you 
skip ahead. For example, placing a chapter at the 7 minute mark of your project will allow you to 
skip directly from the beginning frame to the 7 minute point, rather than fast forwarding through 
the video. It will also allow you to start your disc at this point directly from the DVD menu rather 
than from the beginning.

Chapters can be inserted at the beginning of each scene or in certain time increments. However, 
in iMovie, the chapters must correspond to the beginning of a clip in the Timeline. Because chap-
ters mark jump points, they have set “beginnings” but no set “ends” - a chapter only “ends” when 
a new chapter starts.

To Add Chapters to Your Project:

1. Make sure you have your clips in order in the Timeline and 
are finished editing.

2. Click on the “Chapters” button in the Tools bar.

3. Single-click on a clip in your Timeline to select it.

4. Click on the “Add Chapter” button. A chapter will be gener-
ated to correspond to the time at which this clip starts.

5. Repeat steps 5 and 6 for each additional clip at which you 
would like a chapter to start.
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Still Frames and Image Files
Creating still frames and image files (.jpg or .pict) require a few short steps, almost all of which 
involve selecting the frame you wish to make static. Your first decision will involve whether you 
want to create a still frame or a still image. A still frame is a video with an adjustable duration 
that repeats the same single image multiple times. Essentially, it is a video file of a still image. An 
image file, however, is a single still image.

If you plan to use the still in your iMovie project, you will want to create a still frame. If you plan 
to use the still as an image on your DVD menu, in a PowerPoint slide, or in any printed material, 
you will want to create a still image. The processes for these two outcomes are very similar and 
are both outlined below.

To create a Still Frame:

1. Select the clip you want to use to create your still by clicking on it once. This will highlight it in 
blue.

2. In the viewer, drag the playhead to the frame you wish to make a still. As you drag the play-
head (the triangle on the blue bar at the bottom of the viewer) along the clip’s timeline bar, you 
will see the frames in the clip flash by. Stop at the frame you want to use.

3. Once the playhead has been positioned, go to the iMovie menu and click on “Edit”. 

4. Move your cursor down to “Create Still Frame”.

5. A still frame will be created and placed in your Clip Shelf. The duration of the clip will be 5 sec-
onds.
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6. If you want to change the duration of the clip, you can either edit it as you would a regular clip 
(see page 4 for instructions) or double click on the clip and change the listed duration in the Clip 
Information window.

7. Insert the clip into your timeline at the point you would like it to play.

To Create a Still Image (such as a JPG):

1. Select the clip you want to use to create your still by clicking on it once. This will highlight it in 
blue.

2. In the viewer, drag the playhead (the triangle on the blue bar at the bottom of the viewer) along 
the clip’s timeline bar, you will see the frames in the clip flash by. Stop at the frame you want to 
use.

3. Once the playhead has been positioned, go to the iMovie menu and click on “File”.

4. Move your cursor down to “Save Frame”.

5. The Save dialogue window will launch. Name your file and select its storage location. Click 
“Save”.
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Export, Share or Burn
Although iMovie is a great program for editing your video project, you cannot use it to burn a 
copy of your project to DVD. In order to make a DVD you have two basic options: export your 
project as a file OR launch iDVD and burn a watchable DVD. The option you choose will likely be 
determined by what you want to do with your project. If you want to stream your project on the 
internet, or include it in a PowerPoint presentation, you will want to export it as a .dv file. If you 
want to make a DVD, you will want to launch iDVD from within iMovie.

Burning with iDVD:

1. Make sure you are finished editing your project and adding transitions, titles and chapters.

2. Go to Share in the top menu, then click on “iDVD”. 

4. iDVD will automatically launch and connect to your iMovie project. See the iDVD tip sheet for 
instructions on using iDVD.

Exporting as a File:

1. Make sure you are finished editing your project and adding transitions, titles and chapters.

2. In the iMovie menu, click on “File”.

3. Move your cursor down the File menu options and click on “Share”. A menu like this will ap-
pear:

4. If not already selected, click on “QuickTime” for 
compression options.

5. In the “Compress movie for:” dropdown menu, 
select “Full Quality”.

6. Make sure “Share selected clips only” is NOT 
selected UNLESS you want to create
separate videos from specific clips in your timeline.

Select “Full Quality”

Share ButtonNOT Selected
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7. Click Share.

8. The clips in your timeline will be exported as a separate file. This may take a few minutes, de-
pending on the length and size of your project.
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Glossary
Capture Mode: mode necessary for capturing video; saving and 
editing are not possible when in capture mode; button located 
below the viewing screen.

Capturing: the real time process of bringing previously recorded 
video into iMovie (or another video editing program).

Clip Shelf: the area of the screen reserved for displaying thumb-
nails for individual clips.

Edit Mode: mode necessary for editing and saving; capturing 
is not possible in edit mode; button located below the viewing 
screen.

Playhead: the inverted triangle that represents the frame you are 
currently viewing.

Timeline: the space in which you assemble slips and 
build your video project; located along the bottom of 
the iMovie screen.

Tools Bar: contains buttons for the Clip Shelf, Editing 
Pane, Chapters, etc.; located to the right of the View-
ing Screen and above the Timeline.

Viewing Screen: area of the iMovie screen in which 
you can watch video as it captures and plays; largest 
portion of the iMovie window; located on the upper 
left side.
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